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 1. RABBITFLEX BL300F INTRODUCTION

We all know you cannot fit a square peg into a round hole. But sometimes that is exactly what you are 
asked to do when forced to choose an off-the-shelf single-board computer (SBC) for your embedded sys-
tem application. In the past, price and time constraints could make a custom-designed board unattainable.

That has all changed with the introduction of the RabbitFLEX BL300F. 

Now, you can design your own perfect-fit controller board using Rabbit’s new online design and order sys-
tem, the RabbitFLEX Configurator. Because the controller board is customized during surface mount 
assembly, a custom solution can be obtained more quickly and at a lower price than previously possible.

1.1 RabbitFLEX BL300F Options

The items in the following list may be specified to customize your board design.

• PowerCore Module
PowerCore 3800 (Ethernet, 512 K Flash, 1 MB SRAM, 1 MB Serial Flash)
PowerCore 3810 (512 K Flash, 256 K SRAM)

• Serial Communication Channels
RS-232 (3- or 5-wire)

RS-485 (2-wire) or a RabbitNet porti

• ADCs
Up to 16 ADC channels

• DACs
Up to 2 DAC channels

• Digital I/O
Up to 40 pins for combinations of:

• Digital Inputs

• Sinking Outputs

• Sourcing Outputs

• Line Drivers

• Bidirectional lines

• PWM
Up to 4 PWM outputs

• External Interrupt

• External Reset

i. RabbitNet is a proprietary serial protocol used with a line of peripheral devices for adding extra I/O, 
ADCs, DACs, relays, or an additional keypad/LCD interface. See the RabbitNet User’s Manual for more 
information.
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• Keypad
Range of matrix keypad options: m x n, where m+n <=8

• LCD
With or without backlight and/or contrast control

• Power Routing
5 V available on all user-selectable connectors
3.45 V available on most connectors

1.2 The RabbitFLEX Configurator

When designing and ordering a RabbitFLEX BL300F, you have the opportunity to tailor the board accord-

ing to the demands of your application and not to limitations imposed by an off-the-shelf SBC. You are in 

control when you design a board using the RabbitFLEX Configurator. 

1.2.1  Configurator Access

The RabbitFLEX Configurator is available at:

www.rabbit.com/products/RabbitFLEX

From the above location you can order a customized board, check previous orders, or peruse the site for 

ideas and tips for your design. 

All information entered at the website is secure and confidential—nobody but you or those whom you 

authorize will be able to see the board designs you have saved or ordered. You will be asked to log in to 

your account with a user name and password when you save, order or reload a board design. 

1.2.2  Ordering Information and History

An XML file encapsulates the board design. It can be downloaded by a person who has password access to 

it. The design file is very important. You must safeguard this file to ensure that you will be able to reorder 

the design or to derive other designs from it.

A customized Dynamic C library file is automatically generated when a board design is ordered. The 

library file is downloadable from the RabbitFLEX Configurator. This file is necessary for proper operation 

of library functions for your board. 

See Section 6.2 for more information on RabbitFLEX BL300F files.

1.2.3  Assumptions

The following assumptions are made regarding the use of the RabbitFLEX Configurator:

• Compatible Web Browsers - Internet Explorer ver. 6 or later, Mozilla and Firefox are all compatible 
with the Configurator interface.

• You should have a clear and comprehensive idea of your application parameters before selecting 
the options for your RabbitFLEX BL300F. 

• An electrical engineering background is recommended to make the best decisions among the 
options available. 
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1.3 RabbitFLEX Tool Kit

The RabbitFLEX Tool Kit contains the software and the extra hardware needed to develop your applica-

tion. This section lists the tool kit items.

Tool Kit Items

• RabbitFLEX BL300F Getting Started Instructions.

• Programming cable, 10-pin header to DB9 connector with integrated level-matching circuitry.

• 48 V AC, 800 mA center-tapped transformer. A transformer compatible with power outlets in con-
tinental Europe is included with kits sold overseas.

• CD, containing Dynamic C 9.41 (or later) with complete product documentation, including this 
manual: the RabbitFLEX BL300F User’s Manual.

• Demonstration board with pushbutton switches and LEDs.

• Cable assemblies to access connectors on RabbitFLEX BL300F.

• Hardware bag containing mounting standoffs and screws, female DB9 connector.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.

1.4 CE Compliance

Equipment is generally divided into two classes.

These limits apply over the range of 30 to 230 MHz. The limits are 7 dB higher for frequencies above 230 

MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-based systems at frequencies 

above 300 MHz are generally well below background noise levels.

The RabbitFlex single-board computer has been tested and was found to be in confor-

mity with the following applicable immunity and emission standards. Boards that are 

CE-compliant have the CE mark.

NOTE: Earlier versions of the RabbitFlex boards that do not have the 
CE mark are not CE-compliant.

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:
less than 40 dB µV/m at 10 m
(40 dB relative to 1 µV/m) or 300 µV/m

More restrictive emissions requirement:
30 dB µV/m at 10 m or 100 µV/m
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1.4.1  Immunity

The RabbitFlex series of single-board computers meets the following EN55024/1998 immunity standards.

• EN61000-4-3 (Radiated Immunity)

• EN61000-4-4 (EFT)

• EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment. 

1.4.2  Emissions

The RabbitFlex series of single-board computers meets the following emission standards.

• EN55022:1998 Class A

• FCC Part 15 Class A 

Your results may vary, depending on your application, so additional shielding or filtering may be needed to 

maintain the Class A emission qualification.

1.4.3  Design Requirements for CE Compliance

Note the following requirements for incorporating the RabbitFlex series of single-board computers into 

your application to comply with CE requirements.

1.4.3.1  General Design Requirements

• The power supply provided with the Tool Kit is for development purposes only. It is the customer’s 
responsibility to provide a CE-compliant power supply for the end-product application.

• The LCD/keypad module was tested with the RabbitFlex, but no ESD testing was done. It is the 
customer’s responsiblity to provide a properly designed enclosure for the LCD/keypad interface to 
meet ESD requirements.

• When connecting a RabbitFlex single-board computer to outdoor cables, the customer is responsi-
ble for providing CE-approved surge/lightning protection.

• Rabbit recommends placing digital I/O or analog cables that are 3 m or longer in a metal conduit to 
assist in maintaining CE compliance and to conform to good cable design practices.

• When installing or servicing the RabbitFlex board, it is the responsibility of the end-user to use 
proper ESD precautions to prevent ESD damage to the RabbitFlex board. 

1.4.3.2  Safety Design Requirements

• All inputs and outputs to and from the RabbitFlex series of single-board computers must not be 
connected to voltages exceeding SELV levels (42.4 V AC peak, or 60 V DC).

• The lithium backup battery circuit on the RabbitFlex single-board computer has been designed to 
protect the battery from hazardous conditions such as reverse charging and excessive current flows. 
Do not disable the safety features of the design.
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1.4.4  Interfacing RabbitFlex to Other Devices

Since the RabbitFlex series of single-board computers is designed to be connected to other devices, good 

EMI reduction practices should be followed to ensure compliance. CE compliance is ultimately the 

responsibility of the integrator. Additional information, tips, and technical assistance are available from 

your authorized Rabbit distributor, and are also available on our Web site at: www.rabbit.com.

1.5 What to Expect

This manual describes the RabbitFLEX BL300F, its core module choices and the hardware and software 

components for the sample applications. Your level of experience determines which chapters to read next.

Chapter 2 - Read this chapter for instructions on connecting the hardware and installing the software you 

will need to develop your application. This chapter also contains contact information and some trouble-

shooting tips if you experience difficulty running some initial sample programs.

Chapter 3 - Read this chapter for an understanding of the physical implementation of the logical function-

ality of the RabbitFLEX BL300F. This chapter contains a roadmap of the RabbitFLEX board and design 

units that will allow you to identify the physical location of circuit components, such as specific resistors, 

capacitors, etc.

Chapter 4 - Read this chapter for information on the RabbitFLEX BL300F options that are available. This 

chapter contains circuit schematics and characterization tables for the different options.

Chapter 5 - Read this chapter for links and references for more details on the RabbitFLEX BL300F 

options. This chapter also contains some more in-depth discussions on selected topics. 

Chapter 6 - Read this chapter to understand the software specifics needed for programming your Rabbit-

FLEX BL300F.

Appendix A - Contains the electrical, mechanical and environmental specifications of the RabbitFLEX 

BL300F.

Appendix B - Contains information on power and ground.

Appendix C - Contains information on the demonstration board that comes with the RabbitFLEX BL300F 

Tool Kit.

Appendix D - Contains information on the RabbitFLEX Keypad/Display Kit
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 2. GETTING STARTED

The information in this chapter will get you up and running. Follow the instructions given here to install, 

connect and verify the software and hardware components.

2.1 Hardware Preparation

This section physically prepares the RabbitFLEX board for use in developing and debugging applications. 

As a way to place the board in a more convenient position for development, the first thing to do is screw 

on the hex standoffs that came in the RabbitFLEX as shown in Figure 2.1.  

Figure 2.1  Connecting Standoffs to the RabbitFLEX BL300F
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2.1.1  Hardware Connections

There are two steps to readying the RabbitFLEX BL300F for use with Dynamic C: 

1. Connect the programming cable between the RabbitFLEX BL300F and the host PC where you will 
install Dynamic C. 

2. Connect the power supply. 

The core module comes attached to the RabbitFLEX BL300F from the factory. The core module and the 

board it is attached to are a matched set. They must be used together. Do not remove the core module and 

attach a different core module to the RabbitFLEX board.

2.1.1.1  Connect Programming Cable

The programming cable completes the communications channel for downloading programs to the core 

module. Once a program has been downloaded and is running, you can debug it over the programming 

cable.

Connect the 10-pin connector labeled PROG on the programming cable to header J2 on the PowerCore 

module as shown in Figure 2.2. 

Attach the other end (the DB9 connector) of the programming cable to a COM port on the host PC. Some 

PCs now come equipped with a USB port and no COM port. In this case, you can connect the program-

ming cable’s DB9 connector to a RS-232/USB converter (Rabbit Part No. 540-0070), and then plug the 

other end of the converter into the USB port of the host PC.

Figure 2.2  Programming and Power Connections
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2.1.1.2  Connect Power

Connect the locking plug of the AC adapter to connector J3 on the PowerCore module as shown in 

Figure 2.2. When the other end of the AC adapter is plugged into a power source, a small red LED labeled 

DS1 on the RabbitFLEX board (located in the corner by connector J5) will come on.

You can cycle power to the board by unplugging and then plugging in the AC adapter. There is a  reset but-

ton located on the top-right corner on your board that can be used restart the microcontroller. 

2.2 Software Preparation

Dynamic C version 9.41 or later must be installed on the host PC before you can download any programs 

to the RabbitFLEX BL300F.

2.2.1  Installing Dynamic C

Insert the installation disk or CD in the appropriate disk drive on your PC. The installation should begin 

automatically. If it doesn’t, issue the Windows “Run...” command and type the following command:

<disk>:\SETUP

The installation program will begin and guide you through the installation process. Your IBM-compatible 

PC should have at least one free COM port and be running Windows 95 or later.

Now you must make your board-specific library available to Dynamic C. The board-specific library is the 

one that was generated when you ordered your board. If you have not already downloaded this file, follow 

these steps.

1. Log in to your RabbitFLEX Configurator account at:

 www.rabbit.com/products/RabbitFLEX 

2. Select your RabbitFLEX board(s) from your list of boards to get the corresponding library or libraries, 
which are named FAxxxxxxx.LIB.

3. Do not change the library name(s). You will be prompted during the download process for the location 
to save the library or libraries. It is recommended that you use the LIB\RabbitFlex_SBC40 folder 
that was created during the Dynamic C installation process. 

2.2.2  Starting Dynamic C

Once Dynamic C has been installed, you will have up to three related icons on your PC desktop. One icon 

is for running Dynamic C, one opens the documentation menu and the last one is for the Rabbit Field Util-

ity, a tool used to download compiled software (.bin files) to a target board.

Start Dynamic C by clicking on its desktop icon or by clicking on dcrabXXXX.exe in the Dynamic C 

root directory, where XXXX is the Dynamic C version number.

Dynamic C uses the serial port on the host PC that you specified during installation. If you are using a 

USB port, you must select “Use USB to Serial Converter” from the Communications tab of the Options | 

Project Options menu before downloading a program to the RabbitFLEX BL300F.
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2.3 Verify Serial Connections

Run the sample program pong.c to verify that everything is installed and connected properly. There are 

three ways to open a program from within Dynamic C: the File menu, the File icon or the keyboard short-

cut Ctrl+O. They all open the same dialog box that allows you to browse for the file or type in its path-

name. The sample program pong.c is in the Samples folder where you installed Dynamic C.

Figure 2.3  Open Dialog Box Showing Dynamic C Root Folder

Press function key F9 to compile and run the sample program. Dynamic C will display a status message 

during compilation and download. If Dynamic C reports no errors and the Stdio window then opens and 

displays a small square bouncing around in a box you have verified that the serial connection is function-

ing.

If the program did not compile or run correctly, please see Section 2.5 for some troubleshooting tips that 

may help diagnose and fix the problem.



RabbitFLEX User’s Manual www.rabbit.com 11

2.4 Ethernet Communication

This section describes the additional hardware connections needed to use the RabbitFLEX BL300F Ether-

net port. An Ethernet port is available on the PowerCore 3800, but not on the PowerCore 3810. You must 

have a core module with an Ethernet port and your host computer will need one as well. You may create a 

direct or an indirect network connection from the target board to the host computer. The core module uses 

traditional 10Base-T Ethernet, with an RJ-45 jack which is shown in Figure 2.4.

Figure 2.4  RJ-45 Connector on the PowerCore 3800

To communicate on a network, the RabbitFLEX board must be connected to the network with the appro-

priate cable and the board must be assigned an appropriate IP address. Other addresses may be necessary, 

depending on whether the network is isolated or is addressable on the Internet. For development, it is bet-

ter (read easier) to use an isolated network as opposed to one connected to the Internet. Either is possible, 

and both will be discussed here.

Before proceeding you will need to have two straight through Ethernet cables and a hub, or a crossover 

Ethernet cable. The Ethernet cables and a 10Base-T Ethernet hub are available from Rabbit in the TCP/IP 

10Base-T Accessory Kit. More information is available at: www.rabbit.com
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2.4.1  Direct Connection

A direct connection means that a crossover cable connects the target board to the host computer 
running Dynamic C. Plug one end of the crossover cable into the RJ-45 jack on the core module 
and the other end to the network interface card in your host PC.

2.4.2  Indirect Connection

An indirect connection means that a straight-through cable connects the target board to an Ethernet net-

work via a hub. 

2.4.3  Setting IP Addresses

IP addressing is necessary to communicate on networks. IP addresses are like street addresses or phone 

numbers in that they associate a unique number with an entity. Just as no two devices can have the same 

phone number, no two devices on a network can have the same IP address. 

The Dynamic C implementation of TCP/IP makes network configuration very easy. In most cases an appli-

cation only needs to define the configuration macro TCPCONFIG. This configuration macro is used to 

define other configuration macros. In the sample programs you will see TCPCONFIG defined as 1. This is 

the default network configuration, which will bring up the Ethernet interface and assign default IP 

addresses for the system, as well as a netmask. 

You only need to set the network configuration in Lib/tcpip/tcp_config.lib for most sample 

programs to work. The following line of code was taken from tcp_config.lib: 

#define _PRIMARY_STATIC_IP  "10.10.6.100"

The IP address is a 32-bit number that is expressed in the dotted decimal format shown in the above 

#define statement. Unless there is a need to set a specific IP address to your Rabbit-based device, you may 

proceed with the default address of 10.10.6.100. Otherwise, open tcp_config.lib and replace "10.10.6.100" 

with the IP address for your Rabbit-based device. If your device is on a local network, this change may be 

sufficient; however, if your device is addressable over the Internet, you must also set the macro 

MY_GATEWAY to the IP address of the default gateway (router) used by your network. 

The Dynamic C implementation of TCP/IP supports subnetting. Subnetting is done with a logical bitwise 

AND of a netmask and the IP address. The following line of code was taken from tcp_config.lib: 

#define _PRIMARY_NETMASK "255.255.255.0"

If you do not know the correct values for your IP address and netmask, ask your network administrator.

If you have created an isolated network of just the PC running Dynamic C and the RabbitFLEX BL300F, 

you can use any IP address and netmask that you like as long as they are in dotted decimal format and are 

on the same network. For example, if using the default netmask, the first three octets of each IP address 

must match. 
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2.4.4  Verify the Ethernet Connection

Run the sample program ping.c to verify that everything is connected properly. The sample program 

ping.c is in the \Samples\tcpip folder where you installed Dynamic C.

Press function key F9 to compile and run the program. Dynamic C will display a status message during 

compilation and download. If Dynamic C reports no errors and the Stdio window then opens and reports 

that ping responses were received from the remote host, as shown in the screenshot in Figure 2.5, you have 

verified that the network connection is functioning.

Figure 2.5   Output from ping.c 

2.5 Troubleshooting Tips

This section discusses troubleshooting tips to try when the above instructions did not result in the error-

free running of the pong and/or ping program. There are various conditions to double-check. 

If you see the message “No Rabbit Processor Detected” 

• Be sure the programming cable is attached securely and that it is not misaligned or backwards. 

• If your PC is busy running concurrent tasks, try lowering both the Debug and Download baud rates. Or 
exit the concurrent tasks. 

• If you have something like Palm Desktop running, it may monopolize a serial port. Disable this pro-
gram, or others like it (that is, any program that uses the serial port and stays open in the background). 

• Use the power supply that came in the Tool Kit. Make sure it is attached securely. 

• If you need to use a USB to serial converter, use the one sold at: 

www.rabbit.com/products/rs232_usb_cable/index.shtml

since it has been tested for compatibility. Others may work as well, but some may not.

• Do some basic debugging. For example, see if there is power at the core module and check the 3.45 
regulator. Figure 2.6 shows the points to probe with a multimeter. They are located in the lower right-
hand side of the module and are labeled “A” through “F.” Table 2-6 describes  the labeled test points 
and the voltages you should expect to see.
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Figure 2.6  Test Points for Checking Voltage Levels on the PowerCore 3800

If you see the message “Could not open serial port” 

• Another program (for example, a terminal emulator) is already using the COM port you chose for 
Dynamic C or the programming cable is not attached to the correct COM port on the PC. To change the 
COM port Dynamic C will use, choose Options > Project Options and click the Communications tab. 
Select another COM port from the Serial Port pull-down menu. 

If you see the message “Timeout while waiting for response from target” 

• Check the programming and power cable connections. 

• You might have a baud rate mismatch problem. Choose Options > Project Options and click the Com-
munications tab. Select a different value in the Debug Baud Rate dropdown menu. 

• If you have a very slow PC or are doing other CPU-intensive tasks at the same time Dynamic C  is try-
ing to download, you might get other timeout error messages. Dynamic C needs a lot of CPU time dur-
ing a download. Try stopping the other tasks to see if it helps. 

Table 2-6.  Description for Test Points in Figure 2.6 

Test Points Expected Measurement

A, B, C: These pins are the center-
tapped power supply input. “B” is 
ground. Both “A” and “C” measure 
the voltage coming from the external 
power supply  

From B to A, 12 V AC or higher

From B to C, 12 V AC or higher

D: This capacitor terminal is an easy 
place to access the board-level 
ground.

E, F: These pins are the output and 
input, respectively, of the 3.45 V 
regulator.

From D to E, approx. 3.45 V DC

From D to F, approx. 5 V DC
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Problems During and/or at the End of Compilation 

• A few computers have trouble handling the default 115,200 baud rate. Change the stop bits from 1 to 2 
in the Communications tab of Project Options. If that does not work, slow the baud rate to 57,600 and 
try the compilation again.

2.7 Contact Information

If there are any questions at this point: 

• If you purchased your RabbitFLEX BL300F through a distributor or through a Rabbit partner, contact 
the distributor or partner first for technical support.

• Check the Rabbit Technical Bulletin Board at: www.rabbit.com/support/bb/. 

• Use the Technical Support e-mail form at: www.rabbit.com/support/.
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 3. DESIGN IMPLEMENTATION AND

INFORMATION

This chapter discusses the implementation of the RabbitFLEX™ SBC features. We start with information 

about the basic bare board, which is used as the foundation for all RabbitFLEX™ SBC boards. This foun-

dation board is called the base board. Next, we discuss the physical and logical components that make up 

the feature set selected during the online ordering process. 

3.1  General Board Information

This section describes the RabbitFLEX BL300F base board and provides a high-level diagram of the sub-

system options. 

3.1.1  Base Board Layout 

The base board for a RabbitFLEX BL300F is pictured in Figure 3.1. 

Figure 3.1  Base Board for RabbitFLEX BL300F
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3.1.2  Board-Specific Information

The PowerCore module and the board to which it is attached are linked by more than their physical con-

nection. Switching the mated core module is not recommended, as the calibration and design numbers are 

contained in the core module and will thus no longer match the board.  

3.1.2.1  System ID Block 

The System ID block is a reserved area in flash memory that contains identification information for the 

core module and the design number for the RabbitFLEX BL300F. All RabbitFLEX BL300F devices have 

System ID blocks of version 5 or later. The information fields contained in the System ID block are 

described in the Rabbit 3000 Designer’s Handbook.

3.1.2.2  User Block

The System ID block has information about the User block. The User block is where calibration constants 

are stored. There is memory in the User block for other persistent data that may be required by your appli-

cation.

3.2 Cells and Circuits

The magic of a flex board is the innovative design of the cells, which are abstracted to a level that allows 

them to implement one of multiple functions that may be chosen by you, the board designer.

3.2.1  Cell Definition

Cells can be configured or unconfigured. Unconfigured cells are the basic structure unit at the PCB level. 

An unconfigured cell can be configured to implement one of several logical functions, thus making it a 

configured cell. A configured cell is one in which circuitry has been assembled to form a single function 

on a RabbitFLEX board, such as an I/O pin or a serial port. 

3.2.2  Cell Descriptions

There are different types of cells available. Each one is designed to handle different types of circuits. Each 

I/O pin is supported by a one-transistor or two-transistor cell on the RabbitFLEX BL300F board.

The one- and two-transistor cell layouts pictured in Figure 3.2 and Figure 3.3 can be used along with the 

board layout pictured in Figure 3.4 to determine the placement of components on your board. The pad 

labels (R2A, R2B, Q1B, etc.) that you see in the cell layout diagrams correspond to the component desig-

nators in the circuit schematics.

For example if you look at the circuit diagram for the 1.4 V trigger threshold digital input, you will see that 

the 100 ohm resistor is labeled “R6.” Looking at the one-transistor cell layout, “R6” is located in the 

lower-right corner of the cell. The physical placement of “R6” is different when a two-transistor cell is 

used to implement the 1.4 V digital input.
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3.2.2.1  One-Transistor Cells

Figure 3.2 shows the complete layout of a one-transistor cell. A one-transistor cell can handle dig-
ital inputs, certain outputs, bidirectional logic and keypads.  The one-transistor cells on connector 
J4 can also be used as analog inputs. 

Figure 3.2  One-Transistor Cell 

3.2.2.2  Two-Transistor Cells

A two-transistor cell is required for all sourcing outputs and the 1 A sinking output. The two-transistor 

cells on connector J3 can also be used as analog inputs. You can use any circuit that can be placed in a one-

transistor cell, but not vice-versa.

Figure 3.3  Two-Transistor Cell
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